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Please note: 
The CE marking is an EU directive compliance mark and may only be affixed to products for 
which a directive applies, which provides the CE marking. 
At PROTEC these are medical devices that are intended for use in human medicine. For the 
identical products which are intended for use in veterinary medicine, the CE marking is excluded. 
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Overview of documents 

Please also note the documents below. The current document is highlighted in bold.  

 5320-0-0002 – PROPAXX User manual 

 5320-0-0004 – PROPAXX Installation manual 

 PROPAXX Customize finding template 

 5320-0-0026 – PROPAXX System requirements 
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1. Product Information 

1.1 Intended purpose 

The product PROPAXX is a software for image data processing, transmission, diagnosis and archiving in the 
conventional radiology. 

1.2 User group 

The software PROPAXX is intended for use only by professional users who are trained in the operation of diagnostic 
software in accordance with the respective national regulations and who were instructed in the appropriate 
handling, use and operation as well as in the permitted connection with other medical devices, objects and 
accessories. Appropriate user groups can be e.g. radiological technologists, radiologists, surgeons, emergency 
surgeons, orthopedics and other trained medical staff. 

1.3 Correct Use 

PROPAXX is solely determined for applications according to a.m. intended purpose. 

The product is suitable for applications in the human medicine as well as in the veterinary medicine. All sections or 
figures in this manual which are only relate to the use in the veterinary medicine are marked with the keyword “  
VET version”. 

Correct usage involves observance of the manual as well as complying with the installation instructions and system 
requirements. 

Any actions deviating from what is deemed to be correct usage will lead to the guarantee becoming null and void. 

The operator is liable for all damage occurring as a result of incorrect usage and faulty operation. 

Correct usage also involves the observation of all local rules and regulations concerning safety at work and safety 
from radiation. 

1.4 Incorrect Use 

Any other use or use beyond what is specified is deemed to be not for the intended purpose. The manufacturer 
accepts no liability for damage resulting therefrom. All risk is solely by the user. 

1.5 Technical information 

The measuring accuracy of the measuring tools contained in CONAXX is determined by the pixel size (e.g., 150μm) 
of the modality. The measurement results are rounded to two decimal places in the display.  
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2. Notes 

2.1 Conformity 

The product has been subjection to a conformity acceptance procedure in accordance with the relevant guidelines 
of the European Union for this product and conforms to the demanded fundamental requirements of these 
guidelines. 

2.2 General Notes 

This manual forms an integral part of the software. It must be kept available for the user. Precise observance of this 
manual is a precondition for use of the software for the intended purpose and for its correct operation. This manual 
should be passed on to any future purchaser or operators.  

Although the product was subject to a risk analysis and the design corresponds to the current state of the art, 
residual risk will remain in clinical use. These are displayed in the following user manual by application limitations, 
warnings and precautions. 

The manual conforms to the current state of the software at time of first use. All procedures, names, software 
programs and devices named in this document are registered names. 

PROTEC® reserves the right to change this information without notice and makes no warranty with respect to this 
information. PROTEC® shall not be liable for any loss or damage, including consequential damages, resulting from 
the use of this information. 

Any reprinting of the technical documentation, in whole or in part, is subject to prior approval of PROTEC® being 
given in writing. 

The names, organisations and incidents indicated in the screenshots are completely imaginary. Any resemblance 
to existing organisations, names and incidents is pure chance. 

2.3 General Safety Notes 

The product is a medical software and may only be used by trained personnel or someone who can handle the 
product safely. 

The user himself is responsible for the image quality while accepting the image. You can access the raw image at 
any time to avoid mistakes caused by manual image processing. 

In any case of mistake or doubt or fault a further exposure should be done before confirming the anamnese. 

All peripherals (PC, monitor, printer) connected to the system must conform to standard IEC 60950 (EN 60950) or 
must be “UL-listed” and correspond to the system requirements. Not conformable components may cause 
problems or even an image lost. 

PROTEC® is not liable for any incompatibility or other effects which may arise between this software and with any 
software already installed on the computer system. 

2.4 License Conditions 

The use of PROPAXX underlies the “General Software License Conditions” of PROTEC®, which must be confirmed at 
the first installation. The license conditions can be retrieved in the info-section at any time. 

2.5 General Legal Conditions 

Legal guidelines in the form of laws, standards and directives have to be explicitly clarified for the respective site 
where the device is used. This mainly relates for guidelines concerning handling raw data and the use of suitable 
image viewing devices. 

Furthermore, the user/reader of this manual must himself/herself see to it that the guidelines are kept to relating 
to his/her medical association and the panel union/association which is responsible in such matters. 

PROPAXX Software conforms to DICOM. 
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2.6 System requirements 

The software is only executable on such systems (hardware and software) that fulfill the following general system 
requirements. 

 

Recommended PC configuration for PROPAXX (viewer component) 

CPU Min. Intel Pentium IV ≥ 3,2 GHz or multi-core processor ≥ 2 GHz 
Operating system Microsoft® Windows 7 32/64 Bit (min. SP1); 

Microsoft® Windows 8/8.1 32/64 Bit; 
Microsoft® Windows 10 32/64 Bit 

RAM ≥ 2 GB 
Hard disk ≥ 80 GB (if possible ≥ 7200 r.p.m.) 
Graphics card Mind. OpenGL Version 2.0 

Resolution min. 1024 x 768, ≥ 128 MB memory; when using two monitors the 
graphics card must have two interfaces. 

Supported chipsets: 
- NVIDIA at least GeForce 8000 series 
- ATI at least Radeon X1 series 
- Intel at least HD Graphics series; no support for GMA series 

For 10-bit grayscale resolution: 10-bit monitors und 10-bit graphics card 

Monitor Color or grayscale monitor with a resolution min. 1024 x 768, for diagnosis please 
consider the law 

Mouse, keyboard Standard PS/2 or USB 
Disk drive CD-ROM ≥24x 
CD/DVD writer required for use of the Patient CD function 
Network card network card with min. 100 MBit/s 

 

Recommended PC configuration for PROPAXX (server component) 

CPU Min. Intel Pentium IV ≥ 2,4 GHz or multi-core processor ≥ 1,8 GHz 
Operation system Microsoft® Windows 7 32/64 Bit (min. SP1); 

Microsoft® Windows 8/8.1 32/64 Bit; 
Microsoft® Windows 10 32/64 Bit 

RAM ≥ 2 GB 
Hard disk ≥ 500 GB (if possible ≥ 7200 r.p.m.) 
Graphics card Resolution min. 1024 x 768, ≥ 32 MB memory; 
Monitor Standard monitor, resolution min. 1024 x 768 
Mouse, keyboard Standard PS/2 or USB 
Disk driver CD-ROM ≥24x 
Network card network card with min. 100 MBit/s 
Archive RAID 1 or higher, please consider the law 
Power supply An uninterruptible power supply (UPS), a voltage stabilizer and an overvoltage 

protection are recommended 

Backup Recommended. 
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3. Important start-up information 

3.1 User roles and access data 

A particular user role as assigned to each user account in PROPAXX (see Table 1) that represents a predefined 
number of rights. 

User Role 1 

Doctor Role 2 

Admin user Role 3 

Dealer Role 4 

Table 1: User roles 

The rights of the individual user roles have a hierarchical structure. Table 2 shows user rights that are relevant for 
the viewer. 

Modifying patient data Roles 2 - 4 

Grouping patient images/assigning to another patient Roles 2 - 4 

Accepting images Roles 2 - 4 

Deleting patients, examinations, images, keywords Roles 2 - 4 

Resetting image to raw state Roles 2 - 4 

Managing findings Roles 2 - 4 

Table 2: Viewer user rights 

Table 3 shows Server rights. 

Configuration of the PROPAXX Server Roles 2 - 4 

Backup Roles 3 - 4 

Managing system users Roles 3 - 4 

Table 3: PROPAXX Server user rights 

Table 4 shows an overview of the user accounts that are generated by default during the installation. 

Login name Password Role 

demo demo Dealer 

dealer dealer Dealer 

physician physician Doctor 

useradmin useradmin Admin user 

user user User 

Table 4: Default user accounts 
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3.2 CONAXX-PROPAXX connection 

The following settings must be made if you are using PROPAXX in combination with CONAXX, in order to guarantee 
the communication between both programs. 

3.2.1 Settings in CONAXX 

Define a new connection for the PROPAXX Server in CONAXX through the configuration section "Export > DICOM 
Store", if this is not already in place. You will find more information about the CONAXX settings in the CONAXX 
Manual. The connection data (Remote AE title, Host, Port) must correspond with the data from the configuration 
section "DICOM Send SCP" (see 0) in the PROPAXX Server. 

3.2.2 Settings in PROPAXX 

If necessary, adjust the PROPAXX Server connection data in the "DICOM Storage/Storage Commitment SCP" 
configuration section, so that they match your settings in CONAXX. 

3.3 PROPAXX services 

The communication services settings are listed in Table 5. These are used when configuring the connections to the 
particular services. 

Service Port AE_Title ("Application Entity Title") 

PROPAXX Server 10000 - 

PostgreSQL 5432 - 

DICOM Send SCP (in the PROPAXX Server) 106 PROPAXX 

DICOM Move for DICOM Query (in the PROPAXX Viewer) 108 [PC Name] 

Table 5: PROPAXX services 

4. General 

4.1 Mouse key assignment 

By default, the left mouse button is assigned the function "Windowing" (see 6.5.1.1) and the right button with the 
function "Panning" (see 6.5.1.2). The wheel is assigned the function "Zoom". The selected functions can be used 
through the left button. The function "Zoom" is by default assigned to the mouse wheel. With the middle mouse 
button the function “Magnifier” can be applied. 
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5. Quick guide 

This chapter gives a brief introduction about the recommended workflow with PROPAXX. 

5.1 Starting PROPAXX 

Start the PROPAXX Viewers. 

You have to enter a user and the corresponding password to the login dialog of the PROPAXX Viewer. You can 
select a viewer type for the session if there are more than one viewer types available. After all entries have been 
made, the login process can be finished by clicking on the button “Login”. 

5.2 Open images 

All patients who are stored in the database are available in the administration. The administration can be opened 
via the application menu, keyboard shortcut “F3” or the ribbon tab “Navigation”. 

5.2.1 Open images of a patient 

To find the images of a patient you can use the search function of the administration. If a patient is selected, all 
studies of this patient will be displayed in the list “Studies”. If a study is selected, all images of this study will be 
displayed in the list “Images”. 

5.2.1.1 Open images of a study 

To open images you have to select the images in the list “Images”. Then click on the button “Open”, the context 
menu entry “Open” or double-click on the entry in the list “Images”. At the same time the administration will be 
closed and the image will be loaded. 

To open all images of a study, the study should be selected. Then click on the button “Open”, the context menu 
entry “Open” or double-click on the entry of the list “Studies”. At the same time the administration will be and the 
images will be loaded. 

5.2.1.2 Open studies 

To open a number of studies you have to select the studies in the list “Studies”. Then click on the button “Open” or 
the context menu entry “Open”. At the same time the administration will be closed and the images will be loaded. 

To open all studies of a patient you have to select the patient in the list “Patients”. Then click on the button “Open” 
or click on the context menu entry “Open” of the patient list. At the same time the administration will be closed and 
the images will be loaded. 

5.2.2 Create a work queue 

By creating a work queue, you can change patients in the main window without re-open the administration. To 
add images, studies or patients to the work queue you have to select the images, studies or the patients in the 
corresponding lists (“Images”, “Studies”, “Patients”) and click on the button “Add to work queue”. The administration 
will not closed automatically. You can navigate through the generated work queue in the floating window 
“Navigator” or the ribbon tab “Navigation”. 

5.2.3 Load not yet accepted images 

The button “Open not yet accepted” in the administration will open the not yet accepted images of all patients 
automatically. At the same time a work queue will be created and the administration will close automatically. Not 
yet accepted images or studies and patients who have at least one image which is not accepted are marked in the 

administration by the font style bold. Accepted images will be displayed with a normal font style. 
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5.3 Accept images 

After completing the anamnese you have to accept the image. By accepting the image it will be marked as a 
completed anamnese. You can accept images in the ribbon tab “Navigation”, via the context menu entry “Accept” 
or with the keyboard shortcut “F9”. 

Already accepted images can be accepted again only within 24 hours from the time of the last acceptance. Then 
they must be accepted as new images (in the tab "Navigation" of the ribbon, via the context menu entry "Accept as 
New" or using the keyboard shortcut "F10"). 

If the configuration option “Accept automatically not accepted images” in the section "Automatic operations" of 
the configuration (see 7.3) is enabled, the not accepted images will be accepted automatically as soon as the leave 
the lightbox (e.g. when closing). 

5.4 Navigate between images 

All opened images of the active patients will be displayed in the floating window “Image bar”. You can navigate 
between the images by using the buttons “Previous image” or “Next image” in the ribbon tab “Navigation” section 
“Image”. The images that are not displayed yet in the lightbox, will be loaded in the free tiles or in the last selected 
tile.  

Another way to display an image from the image bar in the lightbox is to double-click with the left mouse button 
on the image in the image bar. Alternatively, hold down the left mouse button and use the drag and drop function 
to place the image in a tile of the lightbox. When the mouse button is released, the image is loaded into this tile. 

5.5 Navigate between patients 

All patients that are represented in the work queue are displayed in the floating window “Navigator”. To change a 
patient you can use the arrow icons in the floating window “Navigator” or double-click on the selected patient. 
Alternatively, the patient could be changed by using the buttons “Previous patient” and “Next patient” in the ribbon 
tab “Navigation” in the section “Patient”. 

5.6 Close PROPAXX 

Therefore close the PROPAXX Viewer. 
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6. Viewer user interface 

The Login dialog appears on each start of the PROPAXX Viewer (see Figure 1). As well as user authentication, this 
window is also used for selecting the language and the viewer type for the session. As well as the corresponding 
name, the viewer type dropdown list contains the number of currently available/free licences and the total number 
of viewer licences for each viewer type in the licence package. For example Xtensive (1/2) means that there are 2 
viewer licences in the licence package for the type "Xtensive" and currently only one is available as the other is in 
use at another Viewer Station. 

  

Figure 1: PROPAXX Viewer Login dialog 

The PROPAXX main window appears after a successful login (Figure 2).  

  

Figure 2: Default layout of the PROPAXX main window 
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6.1 Areas in the Viewer user interface 

The PROPAXX Viewer user interface is divided up into six main areas (see sections 6.1.1 to 6.1.6). Some of these can 
be hidden or repositioned, in order to offer maximum flexibility and optimum usage of the available screen surface. 
Figure 3 and Figure 4 show the general construction of the Viewer user interface with the focus on the particular 
sections. 

  

Figure 3: General screen construction 1 

  

Figure 4: General screen construction 2 

6.1.1 Application menu 

The PROPAXX icon in the left upper part of the main window (Figure 3), opens the application menu, which offers 
general functions. 
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6.1.2 Ribbon 

The ribbon (see Figure 5) represents the area above the lightbox and covers the whole width of the main window. 
The complete functional scope, grouped in themes on tabs and sub-categories can be found in this area. 

 

Figure 5: Ribbon 

6.1.3 Quick access toolbar 

The quick access bar (see Figure 6) is next to the application menu and offers individual, user-definable functions. 
Please see section 6.9 for more information. 

  

Figure 6: Quick access toolbar 

6.1.4 State bar 

The area under the lightbox (Figure 7) represents the state bar, which contains important information about the 
active image and the active patient. The tiling of the window can be done and zoomed in the bar. 

 

Figure 7: State bar 

6.1.5 Additional windows ("Floating Windows") 

Certain functions require additional windows, which, for example, present calculation results. These additional 
windows can be displayed and hidden as required. It is also possible to freely select their position, to embed them 
in the main window, minimised or visible, or to have them as extra windows separate from the main window (Figure 
4) 

6.1.6 Lightbox 

The lightbox is the central area of the main window. Opened images are shown here. Up to nine images can be 
viewed at the same time, which are loaded in the selected matrix size/tiling. A lightbox with a 2x2 tiling is 
represented in Figure 4. 

If images are loaded to the lightbox, many of the program functions for a selected image are available through a 
context menu (see Figure 8). The context menu is called with right click. Important image functions are grouped 
together here, which otherwise are distributed over application menus and the ribbon. The function “Clear tile” 
removes the current image from the lightbox, the image remains in the image bar. The point “Export” > "Copy to 
clipboard" copies the selected image to the Windows Clipboard, making it available for other applications. This 
function can only be called through the context menu or a keyboard shortcut. The function "Synchronize" is only 
available in this context menu and facilitates the adding of individual images to the synchronous mode (see 6.4.7). 
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Figure 8: Context menu of an image opened in the lightbox 
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6.2 Application menu 

The Application menu (Figure 9) is sub-divided in three large parts. General functions are available in the left part. 
The names of the patient records that were last opened are listed in the right-hand part. The lower part offers the 
log out, configuration and exit program functions. 

 

Figure 9: PRPOAXX Application menu 

6.2.1 Administration 

Administration is described in detail in section 6.3.1.1. 

6.2.2 Overview 

The overview is described in detail in section 6.3.1.2. 

6.2.3 Open 

Select the images you want to view through the folder structure of the file system that is opened. Supported image 
formats are DICOM, XYZ, BMP, JPG, GIF, PNG and TIFF. The selected images are loaded to the lightbox. 

6.2.4 Save as 

Saves the image selected in the lightbox as a DICOM file, an anonymized DICOM file or in another supported image 
format (BMP, JPG, GIF, PNG, TIFF) to a location in the file system that has to be defined. If the image is a sequence 
the currently displayed frame will be stored in the image formats BMP, JPG, GIF, PNG, and TIFF. 

6.2.5 Open Patient CD 

This function enables a DICOM-compliant patient CD to be read out. Selecting the corresponding button first opens 
a dialog (Figure 10) with the file system folder structure, where you can navigate to the DICOMDIR file saved on the 
CD and select it. 
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Figure 10: Open DICOMDIR 

The content of the patient CD is shown in the following dialog (Figure 11). The images contained on the CD are 
shown in a tree structure. The name of the patient appears at the highest level. Under this you will find the studies 
and the images they contain. You can select at each level. 

  

Figure 11: Content of a patient CD (DICOMDIR) 

By selecting the images, you have the option to display them in the lightbox ("Open" button) or to import them 
directly ("Import" button). 

6.2.6 Create patient CD 

This function enables the creation of a patient CD from a list of preselected patient images. The list of images to be 
burnt (Figure 12) can be filled from a number of positions in the program, using the function "Add to patient CD" 
(see sections 6.3.1.1 and 6.3). When you click on "Create patient CD", the window shown in Figure 12 opens, where 
all the images to be burnt are listed once again. Images can be removed from the image list before starting the 
burn process. If the "Burn in annotations" checkbox is activated, all the annotations found for these images will be 
taken into account and burnt into the image. By checking the checkbox “CD Viewer” the user can define whether 
the PROPAXX CD Viewer has to be burn onto the medium or not. The patient CD could be exported on a drive by 
clicking on the button “Export”. There are two possibilities to perform the burning process. You can choose a simple 
burning drive (button “Burn”). 
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Figure 12: List of the images that should be burnt on the patient CD 

If you then click on "Burn" (see Figure 12), you are required to enter a description for the burn request (see Figure 
13). This description appears later in the Viewer patient administration, which contains each patient CD. 
Suggestions for this description are generated automatically per default. 

  

Figure 13: Create label for the patient CD 

Now a burn request is created from the image list and the images and patient data are prepared for burning (see 
Figure 14). 

 

 

Figure 14: Send request to create the patient CD 



PROPAXX 
User manual 

PROTEC® GmbH & Co. KG Page 22 of 100 

 

Once all preparations are finalised, the complete burn request is sent to the burning tool (Figure 15), which actually 
writes the data to the CD/DVD. Here, you have the option to define the drive, the speed and the name for the burn 
request and to start the burning of the CD/DVD ("Start" button). The burn process then runs independently of the 
PROPAXX main application and does not impact on further work with the Viewer by generating any waiting times. 

Clicking on the -button you can open the folder which contains the data prepared for burning. 

 

Figure 15: External burning tool 

The sending of the burn request is completed for PROPAXX as soon as the burn program user interface opens. 

6.2.7 Send via e-mail 

A selected image can be sent to an e-mail recipient. Firstly a selection of possible image formats is opened (Figure 
16), one of which has to be selected. Once this is done, the window from the installed e-mail client opens, to write 
a new e-mail. If the image is a sequence, the currently displayed frame will be sent. 

 

Figure 16: Sending image by e-mail 

  



PROPAXX 
User manual 

PROTEC® GmbH & Co. KG Page 23 of 100 

 

6.2.8 Print image 

Prints the current image view on the selected printer. Additionally, when generating the print job (see Figure 17), a 
grid pattern and/or a ruler can be printed on the image. A further option allows you to print different views of the 
image: Portrait or landscape. The image can also be scaled. The number of copies of the print can also be defined. 

  

Figure 17: Print image 

6.2.9 DICOM Query 

This function enables the querying of an externally, pre-configured PACS using the DICOM Query communication 
interface. The associated dialog (Figure 18) opens once this function has been selected from the application menu. 
The construction of the DICOM Query user interface is very similar to that of the administration and allows you to 
enter search criteria, based on which the required images can be found and/or preselected. There is a dropdown 
list on the right-hand side of the header in the search criteria area, for selecting the required PACS. The search is 
started by clicking on the "Start" button. The patients that are found will appear in the "Patients" area. Selecting a 
patient causes the resulting studies to be displayed in the "Studies" area. Selecting a study causes the resulting 
images to be displayed in the "Images" area. The selected patients/images in the result can be displayed in the 
lightbox using the "Open" button or with a double-click. These images are subsequently opened and dealt with as 
external images, in the "External images" area in the image bar. 

There is a display in the window's state bar that shows the progress of the current search process. 
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Figure 18: DICOM Query dialog 

6.2.10 DICOM Print 

This function enables the printing of the selected image on a DICOM printer. For executing a DICOM Print job the 
user must choose one of the predefined print profiles (7.8) from the dialog (Figure 19) which appears selecting this 
function. This function is for sequences not available. 

 

Figure 19: DICOM Print Dialog 

6.2.11 CONAXX 

This button offers a convenient way of switching to the CONAXX program. CONAXX is started if it is not already 
running. The "CONNAX" button is disabled, if CONAXX is not installed on the PC. CONAXX also offers an option of 
switching back to the PROPAXX program. 

6.2.12 Remote support 

Clicking on this button starts the program for the remote support. 

6.2.13 Recent patients 

This area in the application menu lists the last patient records that have been opened. The display is limited to 10 
patients. By clicking on one of the entries, the corresponding patient record can be opened again. 

6.2.14 Log out at the Viewer 

The current user can log out at the Viewer using the "Log out" button. 

6.2.15 Configuration 

The configuration is described in detail in section 7. 

6.2.16 Switch off Viewer 

Clicking on “Exit”, logs the current user out and exits the PROPAXX Viewer. 



PROPAXX 
User manual 

PROTEC® GmbH & Co. KG Page 25 of 100 

 

6.3 Navigation 

The functions from the "Navigation" tab (see Figure 20) from the ribbon are described in the following section. These 
are grouped in the sub-areas "Patient", “Lightbox”, "Image" and "Clinical findings". 

 

Figure 20: Navigation 

6.3.1 Patient 

This chapter describes the functions of the sub-section "Patient". 

6.3.1.1 Administration 

The records of all patients that are stored in the database are located in the administration. In general, the 
administration user interface is divided in two areas: Search and Results (see Figure 21). 

 

Figure 21: Patient administration (Human) 

The search function allows a filtering of patients and/or images in the view. You can search by patient or by image. 
More detailed search options are available after activating "Extended search criteria". 

With the  VET version you can search accordingly by owner and details of the animal (see Figure 22).  
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Figure 22: Patient administration (  VET version) 

The event area is separated over three lists (four with the  VET version). The areas "Patients", "Studies" and "Images" 
are the same in both the Human and  VET versions. The  VET version also has the Owner list. Several functions 
are available in each sub-area of the result lists, which can be used for the selection in the corresponding list. The 
more commonly used functions are located in the header of the corresponding list area. A context menu is opened 
by right-clicking on the lower area on the result list. The context menu offers additional functions for each area, 
over and above those that are available through the buttons in the corresponding list area. 

"Owners" list (  VET version) 

In the  VET version, all the owners of the patients/animals that are in the system are listed in the "Owners" area. 
There are no additional functions available for this area. The user can display and/or modify the data of the selected 
owner through the context menu (see Figure 23). 

 

Figure 23: Context menu in the "Owners" area of the administration 

If this menu point “Show / Change owner information” is selected, a dialog (see Figure 24) opens where the current 
data of the selected owner is displayed both in the input fields and in the state bar in the lower area of the dialog. 
Changes to the data in the input fields are only effective after clicking on the "OK" button. 
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Figure 24: Display and modify owner data 

If the menu point “Cut” is selected all patients, findings, studies and images of the owner will be cut. If you then 
select a different owner and open the context menu, it contains a menu point "Paste", which can be used to assign 
the previously cut elements to the selected owner. 

"Patients" list 

All the patients found in the system are listed in the "Patients" area. The user can call up an overview of the stored 

images of a selected patient using the "Overview" button ( ) (see 6.3.1.2). You can create a new x-ray job in 

CONAXX with the “New exposure” ( ) button. The button “Save as” ( ) allows you to export all images of the 
selected patients. In the submenu that pops up when you click on the button, you can select the file format in 

which the images will be saved. The button “Send via e-mail” ( ) allows you to send the images via e-mail. 
Therefore a dialog appears in which you can select the file format (Figure 16). Once this is done, the installed e-mail 

client will open the dialog for a new e-mail. The button "Add to patient CD" ( ), enables images of the selected 

patients to be added to the burn list of a patient CD. The “DICOM Print” ( ) button allows you to print the images 

on a DICOM printer. With the button “DICOM Send” ( ) images can be sent to a PACS. 

Further functions can be reached through this area's context menu (see Figure 25). The context menu can be called 
with a right-click on the corresponding selected patient. 

  

Figure 25: Context menu in the "Patients" area of the administration 1 

By selecting the menu point "Show / Change Patient Information", a dialog is opened where the current user can 
view and/or edit the data of the selected patient, in the same way as with editing the owner data. There is a 
difference between the input dialogs in the Vet (see Figure 26) and Human versions (see Figure 27) of PROPAXX. 
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Figure 26: Display/modify patient data (  VET version) 

 

Figure 27: Display/modify patient data (Human) 

The menu point "Delete" offers the option of deleting the selected patient with all his/her studies, images and 
findings. By selecting the menu point "Cut", all findings, studies and the images of the patient contained within 
them are cut out. If you then select a different patient and open the context menu, it contains a menu point "Paste", 
which can be used to assign the previously cut elements to the selected patient. 

Please note: Patients without studies and documents are deleted from the system. 

Using the “Cancel” button will close the context menu. 

"Studies" list 

All studies for the patient selected in the "Patients" list are displayed in the "Studies" area. As well as the Patient CD 

option, the functions "Send via e-mail" ( ), "DICOM Send" ( ), "DICOM Print" ( ) or „Save as“ ( )  are available for 
selection for the elements in this list. These functions can also be reached through the context menu (Figure 28). 
Here, you have the option to delete examinations and/or to reassign their images through the "Cut" function in the 
same way as with the context menu in the "Patients" list. 
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Figure 28: Context menu in the "Studies" area of the administration 

Please note: Studies without images are deleted from the system. When a patient's last study is deleted, the patient 
is also deleted. 

"Images" list 

All images for the study selected in the "Studies" list are displayed in the "Images" area. This area also offers the option 

of printing the image (  button) on a Windows printer and a thumbnail preview in the administration, in addition 
to the functions already available in "Studies". 

The "Refresh" button ( ) refreshes the image area so that any change in the status of the image is visible. 

  

Figure 29: Context menu in the "Images" area of the administration 

In the same way as the "Studies" context menu, the "Images" list context menu offers the functions from the header 
of this area and the option to delete and reassign images. You can open the DICOM header using the entry “DICOM 
Header”. Additionally, the menu point "Open as reference image" allows an image to be opened at any time as a 
reference image, whether it belongs to the active patient or not. A separate part of the image bar is reserved for 
reference images  

Please note: Reference images cannot be accepted or saved with the entered changes. When the last image from 
a patient's only study is deleted, the patient is also deleted. 

The menu item “Sequence Preview” opens the overview of all frames of the selected sequence. This menu item is 
only available for sequences. Analogously to the image overview this dialog offers functions that are applicable for 
each frame.  
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Figure 30: Sequence preview 

DICOM services 

The services "DICOM Send” and "DICOM Print" can be reached both through the function buttons in the header of 
each list area and through the corresponding context menu. They are executed for selected elements of the 
corresponding area. 

When the function "DICOM Send" is selected, a small dialog opens (see Figure 31) where the target for the despatch 
of images should be defined. All connections that were defined in the configuration section "DICOM Send" (see 7.10) 
are listed in this dialog. 

 

Figure 31: Selection of the DICOM send target 

Once the target is selected and confirmed, the selected elements are sent. The DICOM Send process is completed 
with a status message (see Figure 32). 

 

Figure 32: Status message after successful despatch of an image using DICOM Send 
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If you select the function “DICOM Print” a small dialog opens (see Figure 33) in which the print profile for this print 
job should be defined. All print profiles that were defined in the configuration section “DICOM Print” (see 7.8) are 
listed in this dialog. 

 

Figure 33: Select a print profile 

Once the print profile is selected the print job will be sent automatically to the DICOM printer which is configured 
in the print profile. The DICOM print process is completed with a status message (see Figure 34). 

 

Figure 34: Status message after sending the print job to a DICOM printer successfully 

 
The functions described below are available in the bar at the bottom of the patient administration window. 

Open images 

By double-clicking on a study or an image or by using the “Open” button the “Administration” window is closed and 
the selected studies or images are opened in the lightbox and as a preview image in the image bar. The "Open" 
function is also available through the context menu in the corresponding sub-area. 

It is only possible to display and edit images from one patient at a time in the lightbox. This patient is identified as 
"active" and shown at various locations in the program ("State bar", "Overview", "Administration" and "DICOM header"). 
External images and reference images can be opened at any time. After opening, the preview images of the external 
and/or reference images appear in a separate part of the image bar, separated from the images belonging to the 
active patient. 

Add to work queue 

Clicking on the "Add to work queue" button adds the selection to the end of the work queue, leaving the 
"Administration" window open. If a patient is already “active” and a second one is opened, the second patient will 
become the active patient. The previously opened patient, including all studies and images, is removed from the 
view (image bar and lightbox), but not completely closed. The patient remains in the "Work queue" (see 6.8.1.2) for 
further processing until the record is completely closed. In this way, a patient can be added to the start of the work 
queue. 

Clicking on the "Create Patient CD" button takes you to the dialog with the burn list view (Figure 12), where the burn 
process can be started directly. 

The function "Open not yet accepted" facilitates quick access to the new, not yet viewed and accepted patients and 
images. 

When the Administration is first opened, as standard the last 20 processed patients are displayed, sorted 
chronologically according to the "Last input" column. Then the results of the last search are always shown. This can 
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be disabled in the configuration section "Automatic steps" (see 7.2) by activating the "Reset search criteria in the 
administration" checkbox. 

6.3.1.2 Overview 

This function gives you the option of opening an overview of the images for the "active" patient. The images that 
are already opened in the image bar are marked by an activated checkbox under each image (see Figure 35). In this 
way, further images can be selected and loaded to the image bar by clicking on "OK". 

 

Figure 35: Overview of all images of the selected/active patient 

The dialog field also offers access to the functions “Save as” ( ), "Send via e-mail"( ), "Add to patient CD"( ), 

"DICOM Print"( ), "Print image" ( ) and "DICOM Send" ( ) for the selected images. These functions are used on all 
images and can also be reached through the image context menu (see Figure 36). Here you can also open the 
selected image as a reference image. You can open the DICOM header using the entry “DICOM Header”. 

 

Figure 36: Context menu from an image in the overview 

The properties of the selected image are shown in the "Extended Image properties" area, bordered by an orange 
frame. This includes a larger representation of the image as well as a detailed table of the image characteristics and 

their values. Using the   buttons underneath the preview image, you can navigate to the next and/or previous 
image and view its properties. 



PROPAXX 
User manual 

PROTEC® GmbH & Co. KG Page 33 of 100 

 

The name of the patient that the images belong to is shown in the bar in the lower part of the window. 

6.3.1.3 Previous 

If the work queue contains several patients (see 6.8.1.2), you can change to the previous patient using the "Previous" 
button. This closes the images belonging to the active patient. If changes have been made to the images that are 
to be closed, which have not yet been saved/accepted, the user is asked before they are closed, whether the images 
with the changes should be accepted or whether the changes should be discarded. Then the previous patient in 
the work queue becomes the active patient, the patient data in the state bar is updated and the images for the 
new active patient are shown in the image bar and in the lightbox. 

6.3.1.4 Next 

In the same way as with the "Previous" button, you can scroll to the next patient in the work queue using the "Next" 
button (see 6.8.1.2). 

6.3.1.5 Accept 

Accepts the loaded images of the active patient in the "Image bar" and closes them after the acceptance process. 
Images, which have been last accepted longer than 24 hours ago, will be accepted as new images, if they contain 
changes. 

6.3.1.6 Close 

This function closes the loaded images of the active patient in the "Image bar". In the case of changes that have not 
been saved/accepted, the user is asked whether they should be accepted or discarded. 

6.3.2 Lightbox 

This chapter describes the functions of the sub-section "Lightbox". All operations refer to the images in the lightbox. 
In this case, reference images, external images as well as images of an active patient are affected.  

6.3.2.1 Accept 

Accepts the opened images in the "lightbox" and closes them after the acceptance process. In the case of external 
images, the user is asked whether the image should be added to an active patient, if present, or whether the patient 
data from the DICOM header should be used, to store the image in the system. Reference images could not be 
accepted. Images, which have been last accepted longer than 24 hours ago, will be accepted as new images, if they 
contain changes. 

6.3.2.2 Close 

Closes the opened images in the "lightbox". In the case of changes that have not been saved/accepted, the user is 
asked whether they should be accepted or discarded. 

6.3.2.3 Clear 

Clear all tiles of the lightbox. The images leave the lightbox but remain in the image bar.  

6.3.3 Image 

This chapter describes the functions of the "Image" section located on the "Navigation" tab. All operations refer to 
the currently selected image. This can be an external image as well as an image of the current patient.  

6.3.3.1 Accept 

Accepts the selected image and closes it after the acceptance process. In the case of an external image, the user is 
asked whether the image should be added to an active patient, if present, or whether the patient data from the 
DICOM header should be used. Reference images could not be accepted. Images, which have been last accepted 
longer than 24 hours ago, will be accepted as new images, if they contain changes. 
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6.3.3.2 Accept as new 

The selected image is accepted as a new image. For not yet accepted images is this function deactivated until the 
first acceptance.  

6.3.3.3 Close 

Closes the opened image. In the case of changes that have not been saved/accepted, the user is asked whether 
they should be accepted or discarded. 

6.3.3.4 Add to Patient CD 

Adds the selected image (expect external images) to the list of images that are to be burnt to a CD. 

6.3.3.5 Previous 

If several images are opened in an area of the image bar (see 6.8.1.1), you can change to the previous image in the 
corresponding sub-area of the image bar with "Previous". The previous image is that which is located in the image 
bar behind the image that is currently selected. If the previous image is not yet visible in the lightbox, it will be 
loaded in the next free tile. If there is no free tile in the lightbox, the image will be shown instead of the current 
image. 

6.3.3.6 Next 

If several images are opened in an area of the image bar (see 6.8.1.1), you can change to the next image in the 
corresponding sub-area of the image bar with "Next". The next image is that which is located in the image bar ahead 
of the image that is currently selected. If the next image is not yet visible in the lightbox, it will be loaded in the next 
free tile. If there is no free tile in the lightbox, the image will be shown instead of the current image. 

6.3.4 Clinical findings 

This chapter describes the functions of the "Clinical findings" section located on the "Navigation" tab. The following 
goes into detail about the creation of a finding for a patient. With PROPAXX, it is possible create several findings for 
the selected patient and to print them or send them by e-mail. 

6.3.4.1 New 

This opens a dialog (Figure 37), where a description can be defined for the finding that is to be created. The finding 
is then listed under this name (Figure 38). Clicking on "OK" creates a new finding document. The document has the 
patient data added to it and is loaded to the "Finding" window (see 6.8.1.3), where it can be edited further. 

 

Figure 37: Create a new finding 
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6.3.4.2 Findings 

All the findings stored for the active patient are shown. These can be selected and edited separately.  

 

Figure 38: Overview of the findings for the active patient 
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6.4 Image 

Each function in this tab from the ribbon (see Figure 39) can only be used once after it has been selected. Once the 
function is completed, the previously used function is activated automatically. By default, the "Windowing" tool is 
selected. If you subsequently select "Invert" for example, once this process is completed, the "Windowing" tool is 
active again. Exceptions are described together with the corresponding “Image” functions. 

 

Figure 39: Image 

6.4.1 Raw image 

The button "Open" in this section opens the raw image of the selected image. The raw image will be additionally 
opened in image bar and shown in the lightbox. 

6.4.2 Reset 

By clicking on the button “All changes”, the changes which have been made since the first load of the selected 
image will be reset to its last accepted state. The contents that were applied to the system when it was accepted 
are not affected and are still available after this step. 

6.4.3 Invert 

Using the "Invert" button in this section of the "Image" tab, the grey scale values of the image displayed in the 
lightbox can be inverted. 

6.4.4 Crop 

This section of the "Image" tab covers the functions involved with cropping the image selected in the lightbox. 

6.4.4.1 Crop Select 

If you click on this button, the mouse pointer changes to a selector cross. By pressing and holding the left button 
on the mouse, you can pull a rectangle over the area that should be cut out. When you release the mouse button, 
a dotted line appears around the selected area and a black mouse pointer appears which allows the user to edit 
the area that has just been selected. 

6.4.4.2 Crop Apply 

A prerequisite for carrying out this function is, that an area that should be cut out has previously been selected with 
the "Crop Select" function. If you now click on this button, the selected cut-out area is shown on the display window, 
duly modified. If no area has been selected before clicking on this button, nothing happens. 

6.4.5 Rotation/Mirror 

If you click on the  or  button, the image turns through 90° in the selected direction, i.e. clockwise or counter 

clockwise. If you click on the  or  button, the image is shown vertically/horizontally mirrored. 

6.4.6 Image properties 

This section deals with the functions from the "Image properties" section on the "Image" tab.  
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6.4.6.1 Image finding 

Clicking on this button a window opens in which a short image finding can be entered (see Figure 40). 

 

Figure 40: Image finding 

In the drop down box “Favorites”, a previously stored text can be used. To add a text to the favorite list the check 
box “Add to favorites” have to be activated before the text is confirmed by clicking the button “OK”. Alternatively, 
the favorite list can be edit in the configuration (see 7.3). 

6.4.6.2 DICOM Header 

If you click on this button, a list of the attributes of the selected DICOM image (the DICOM header) is shown (see 
Figure 41). In this dialog, you have the option to export the DICOM header information in a text file. For this purpose, 
the overview of the file system appears after selecting the "Export" option, to enable you to choose a location to 
save the text file to. After saving, you are returned to the DICOM header listing. Clicking on the "Copy" button copies 
the content of the selected cells to the Clipboard. It is here also possible to filter the DICOM Header elements using 
a search term. 

Non-DICOM images have correspondingly no DICOM header information and therefore, this function is deactivated 
for such images. 
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Figure 41: Display of the DICOM header information 

6.4.6.3 Image comment 

If you click on the  button next to the text display, an input field appears (Figure 42), where an image comment 
can be entered. If you click on "OK", the entered text appears in the text display. If you click on "Cancel", nothing 
appears or any existing comment text is retained. The comment text is only finally saved after the corresponding 
image is accepted. 

 

Figure 42: Edit image comment 

6.4.6.4 Keyword 

A keyword can be assigned to each image. Clicking on the  button next to the keyword text field opens a dialog 
(Figure 43) that lists all the keywords that have already been defined in the system. Here, you can select an existing 
keyword from the list and assign it to the current image. You can also define new keywords and delete existing 
ones from the list. Images that were assigned the keyword that is to be deleted then lose the assignment and no 

longer have a keyword assigned. The assignment can be removed again using the  button next to the keyword 
text field. 
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Figure 43: Edit keyword 

6.4.7 Sync mode 

If several images are opened at the same time in the lightbox, this function can be used to apply the "Windowing", 
"Panning" and "Zoom" functions on all images at the same time, with the exception of the zoom function through 
the mouse wheel. Click on the “On” button in the "Sync mode" section to activate the synchronous mode. The icon 

 appears under the overlay of the images opened in the lightbox. Subsequently selected functions are used 
on all images that are in this mode, irrespective of which image they are used in and whether this image is in 
synchronous mode or not. Through the lightbox context menu, you have the option to add individual images 
explicitly to the synchronous mode and/or to remove them from the mode. 

Using the “Off” button, the synchronous mode can be deactivated for all images where the mode is currently active. 

The icon  disappears. 

6.4.8 X-Ray 

This section deals with the functions from the "X-Ray" section on the "Image" tab. 
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6.4.8.1 New exposure 

If you click on “New exposure” a new window will appear. In this window you can create a new scan job for CONAXX 
(see Figure 44). 

 

Figure 44: New exposure 

In this dialog you can select a QuickJob from the list. Alternatively, you can create a user defined scan job. As a 
parameter a body part, a fine part and a view position has to be selected. By clicking on the button “Send”, the scan 
job will be sent to CONAXX and the dialog will close automatically. You can close the dialog by clicking the button 
“Close”. 

6.4.8.2 Repeat exposure 

An automatically created scan job will be sent by clicking on the button “Repeat exposure”. 

Note: A repeat exposure can only be requested as long as the original image is in CONAXX. 

6.4.9 GDT 

If you click on the button “Send message” in the “image” tab section “GDT” a GDT message will be created as defined 
in the GDT.ini file section [GDTREPLY]. By default, the file name is “propaxx2edv.gdt” and the path is “C:\Program 
Files\PROPAXX Viewer\export”. This file contains patient and image-related data. 
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6.5 Tools 

The functions from the "Tools" tab on the ribbon are described in the following section (see Figure 45). The 
"Windowing" tool is automatically selected when the program is started. This is the starting point for the functions 
described in the following sections. 

 

Figure 45: Tools 

6.5.1 Tools 

This chapter describes the general tools on the "Tools" tab in the ribbon. 

6.5.1.1 Windowing 

This is the default mode. Here, you can define the distribution of the greyscale. Press and hold the left mouse button 
(the mouse pointer changes) and move the mouse over the image. Horizontal mouse movements modify the 
window width of the greyscale area. Vertical mouse movements alter the position of the defined greyscale window 
in the histogram. The "Windowing" mode remains selected. 

6.5.1.2 Panning 

If you click on this button, the mouse pointer changes to a hand. If the image is larger than the predefined field or 
if it has been enlarged by zooming, you can move it within the area/tile where it is loaded, by pressing and holding 
the left mouse button. Clicking on the "Panning" button for a second time takes you out of the mode. 

6.5.1.3 Move image 

This function allows you to move an image from one tile to another. You click on the button (the mouse pointer 
changes) and pull the image that is to be moved from the original tile in the lightbox to the target tile. If the target 
tile is already occupied by an image, the two images swap places. Clicking on the “Move image” button for a second 
time takes you out of the mode. 

6.5.2 Zoom 

This section deals with the functions from the “Zoom" section on the "Tools" tab. In this section, you will find the 
following zoom options that can be used in the complete patient image or in part of an image. 

6.5.2.1 Fit to screen 

If you click on this button, the current image is modified to the size of the display field or tile. The previously selected 
function remains selected. 

6.5.2.2 1:1 

If you click on this button, the image is shown in a 1:1 ratio, i.e. one pixel in the image corresponds to one pixel on 
the screen. The previously selected function remains selected. 

6.5.2.3 Factor 

If you click on this button, you have the option to define the factor by which the image is enlarged or reduced. You 
can either select a predefined value or you can define one yourself. The previously selected function remains 
selected. 
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6.5.2.4 Region 

If you click on this button, the mouse pointer changes to a cross. By pressing and holding the left button on the 
mouse, you can pull a rectangle over the area that should be enlarged. When you release the mouse button, the 
selected area of the image is shown enlarged.  

6.5.2.5 Full screen 

If you click on this button, the image is shown as a full screen image. This can also be achieved with a double-click 
on the image. You can return to normal view with a double-click or through the context menu or with the keyboard 
“ESC”. 

6.5.3 Magnifier 

If you click on this button, the mouse pointer changes to a square. If you move the square over the picture, the area 
within the square is shown magnified. You exit this mode with a second click on the "Magnifier" button. You can 
modify the magnification factor and the size of the magnifier area through the "Factor" and "Size" buttons 
respectively. 

6.5.4 Region Windowing 

If you click on this button and left click on the image and keep the mouse button pressed, you can select the 
required region and then release the mouse button again. Each time the mouse stops moving while the mouse 
button is pressed the windowed image is being calculated.  When the mouse button is released, the windowing 
settings will be applied on the complete image. With this action, the grey scale values of the affected region are 
windowed so that a maximum contrast is achieved. The windowing of the cut-out is used on the complete image 
and on the histogram. You can modify the size of the windowed area through the "Size" button. This function can 
only be used on DICOM images. You can leave the mode by clicking on the button again. 

6.5.5 Windowing 

This section deals with the functions from the “Windowing" section on the "Tools" tab. 

6.5.5.1 Full 

If the "Full" function is used, the grey scale value distribution in the histogram extends over the complete grey scale 
value range and these values are used on the DICOM image. 

6.5.5.2 Fit 

"Fit" causes an optimum grey scale value distribution on the histogram. This distribution is then used on the DICOM 
image. 

6.5.5.3 Reset 

"Reset" causes the window grey scale value properties to be read out of the DICOM header and for them to be used 
on the histogram and the corresponding image. 

6.5.6 Brightness / Contrast 

Clicking on the up arrow causes a brightening or an increase in the contrast of the image. Clicking on the down 
arrow reduces the brightness or contrast settings. 
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6.6 Filter and lookup tables 

The following section describes the functions on the "Filter/LUT" tab (see Figure 46) on the ribbon. 

 

Figure 46: Filter and lookup tables 

6.6.1 Filter 

Here you have the option of using various filters on the image. The actively used filter is shown in the overlays. 
Clicking on the "Reset" button displays the unfiltered image again. 

6.6.2 Characteristic curves 

The visible grey value range of the image is transformed based on a predefined function. 

6.6.3 Lookup tables 

Predefined lookup tables are available for selection in this area. A look up table defines a new grey scale or colour 
value for each grey scale value from the grey scale value range. When the lookup table used, each pixel in the image 
is assigned a new value, according to this assignment, in order to achieve an alternative representation of the image. 
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6.7 Annotations and measurements 

The following is true for all the buttons in the ribbon (see Figure 47): If the function is not executed but a second 
click is made on the button to switch the function off again, you are returned to "Windowing" mode. If the functions 
are executed, you are then in "Select objects" mode, unless otherwise described. 

 

Figure 47: Annotations and measurements 

6.7.1 Text 

This section deals with the functions from the “Text" section on the "Annotation / Measurement" tab. 

6.7.1.1 Abc 

The predefined texts can be selected from the dropdown list linked to this button. If you click on the button, an 
input dialog opens (see Figure 48), where a freely definable text can be entered. After confirming, you can place 
the text. The text can be modified retrospectively in terms of colour and size.  

 

Figure 48: Input of annotation text 

6.7.1.2 Left/right marker 

These functions allow you to set left/right markers in the image. After clicking on these buttons, the selected marker 
can be placed at any position in the image. The markers can be made larger or smaller retrospectively. 

6.7.2 Insert shapes 

Using these functions, you can add shapes ( , , , ) to the image, in order to highlight a particular area of 
the image. You click on the corresponding button and with the left mouse button held down, you drag the mouse 
pointer over the image. Once the shape is finished, you release the mouse button. The shapes can be modified 
retrospectively in terms of colour and size. 

6.7.3 Densitogram 

Using this function, a greyscale profile can be created for a predefined section of the image. Clicking on this button 
changes the mouse pointer to a line drawing tool. The section of the image for which the profile should create is 
defined with this line, which can be drawn on the image with the left mouse button held down. When the line is 
complete, an additional window (see Figure 49) appears where the greyscale profile is shown. In this window you 
have the possibility to export the greyscale profile as an image or to copy the greyscale profile to the Clipboard. 
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Figure 49: Densitogram 

6.7.4 Measurement 

This section deals with the functions from the “Measurement” section on the "Annotation / Measurement" tab. 

6.7.4.1 Distance 

This function can be used to measure a distance in the image. To do this, click on the  button, position the mouse 
pointer at the starting point and then with left mouse button held down, move it to the end point. Then the length 
of the distance is displayed. The basis for this measuring function is the data from the "PIXEL_SPACING" or 
"IMAGER_PIXEL_SPACING" tag in the DICOM header of the corresponding image. If this data is not available, a pixel 
is used as the unit. A calibration (see 0) can be carried out if a reference object with a known scale is present in the 
image. 

6.7.4.2 Angle 

Using this function, an angle within the image can be measured. To do this, click on the  button, mark the starting 
point of one axis with a left click, mark the point of the angle with a second click and finally mark the end point of 
the second axis with a third click. Then the size of the angle is shown in degrees.  

6.7.4.3 Circle 

This function allows a circle measurement with the indication of the radius of the circle. This is done in a series of 

steps. After selecting the  tool, the mouse pointer changes to a cross with a circle and a "1". Now you have to 
define the centre of the circle. This is done by making a left click on a position in the image. The next mouse click 
defines the radius of the circle. Once the last action has been carried out, the radius can be read off. 

6.7.4.4 HD Angle 

This function allows a so-called hip dysplasia angle measurement to be made. This is done in a series of steps. After 

selecting the  tool, the mouse pointer changes to a cross with a circle and a "1". Now you have to define the 
centre of the circle for the first angle. This is done by making a left click on a position in the image. The next mouse 
click defines the radius of the circle. Once the first circle is defined, the mouse pointer changes to a cross with a 
circle and a "2". Now, the circle for the second angle can be drawn in the same way. Once the second circle is 
defined, the mouse pointer changes again to a cross with an arrow. The last click defines the direction of the angle. 
Once the last action has been carried out, both angles can be read off. After completing the drawing work, you can 
adjust the individual components of the HD angle.  

6.7.4.5 PennHIP measurement 

This function allows a so-called PennHIP measurement. This is done in a series of steps. After selecting the  tool, 
the mouse pointer changes to a cross with a circle and a "1". Now you have to define the centre of the first circle. 
This is done by making a left click on a position in the image. The next mouse click defines the radius of the circle. 
Once the first circle is defined, the mouse pointer changes to a cross with a circle and a "2". Now, the second circle 
can be drawn in the same way. Finally the distraction index (DI = d/r, with d = distance between the center of the 
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femoral head and the center of the acetabulum, r = radius of the femoral head) will be displayed. After completing 
the drawing work, you can adjust the individual components of the PennHIP measurement. 

6.7.4.6 Angle between two lines 

This function allows measuring an angle between two lines. This is done in a series of steps. After selecting the  
tool, the mouse pointer changes to a cross with a line and a “1”. Now you have to define the starting point of the 
first line. This is done by making a left click on a position in the image. The next mouse click defines the end point 
of the first line. Once the first line is defined, the mouse pointer changes to a cross with a line and a “2”. Now, the 
second line can be drawn in the same way. Once the last action has been carried out, the angle can be read off. 

6.7.4.7 Cardiothoracic ratio 

This function allows measuring a cardiothoracic ratio. This is done in a series of steps. After selecting the  tool, 
the mouse pointer changes to a cross with a line and a heart. Now you have to define the starting point of the first 
line (heart). This is done by making a left click on a position in the image. The next mouse click defines the end point 
of the first line. Once the first line is defined, the mouse pointer changes to a cross with a line and a thorax. Now, 
the second line (thorax) can be drawn in the same way. Once the last action has been carried out, the ratio of the 
heart line and the thorax line can be read off. 

6.7.4.8 Tibial-Plateau-Angle (TPA) 

This function allows measuring a tibial plateau angle (TPA). This is done in a series of steps. After selecting the  
tool, the mouse pointer changes to a cross with a line and a “1”. Now you have to define the starting point of the 
first line (tibial plane - right point). This is done by making a leftclick on a position in the image. The next mouse 
click defines the end point of the first line (tibial plane - left point). Once the first line is defined, the mouse pointer 
changes to a cross with a line and a “2”. Now, the second line (axis from top to bottom) can be drawn in the same 
way. Once the last action has been carried out, the angle can be read off. 

6.7.4.9 Vertebral Heart Score (VHS) 

This function allows measuring a vertebral heart score (VHS). This is done in a series of steps. After selecting the  
tool, the mouse pointer changes to a cross with a line, a heart, a “1” and a “L”. Now you have to define the starting 
point of the first line (longitudinal axis measurement). This is done by making a leftclick on a position in the image. 
The next mouse click defines the end point of the first line (longitudinal axis measurement). Once the first line is 
defined, the mouse pointer changes to a cross with a line, a heart, a “1” and a “S”. Now, the second line (short axis 
measurement) can be drawn in the same way. Once the second line is defined, the mouse pointer changes to a 
cross with a line, a heart, a “1” and a “T”. Now, the reference point must be marked on the spine (T4). The direction 
can be defined with the next click. Once the last action has been carried out, the longitudinal axis measurement 
and the short axis measurement will be drawn automatically on the reference point T4. Also a label “VHS = “ will be 

displayed. By clicking on the edit icon ( ) an input window appears. Count the number of vertebrae that fall within 
the caliper points and enter the number in the field “L”. The “S” (short axis measurement) value and the sum (“VHS”) 
will be calculated automatically. To enter the result of the short axis measurement manually the option “Manual 
input” must be activated. The additional window will be closed by clicking on the “OK” button.  
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6.7.4.10 Calibration 

If the DICOM header of the corresponding image doesn't contain any information in the "PIXEL_SPACING" or 
"IMAGER_PIXEL_SPACING" tags, no definitions can be made in metric units for the image. Distance measurements 

can only be made in pixels. This function (  button) enables a manual calibration based on a reference distance 
in the image. An input dialog appears (see Figure 50) when the function is called, where the unit (mm, cm, inch) 
and the length that is to be defined is selected. After confirming with the "OK" button, the mouse pointer changes 
to a drawing tool for the distance measurement, which is used to describe the corresponding distance in the image. 
This distance reflects the predefined length. You can also modify the length of the calibration distance 
retrospectively, in order to adjust the calibration. All changes to the calibration distance are used immediately for 
all measurements in the image and for the ruler. When the function is complete, the calibration distance can be 
deleted from the image again (see 6.7.8). This has no effect on the previously executed calibration and prevents 
any subsequent erroneous operation on the calibration distance. When the calibration is complete, the 
"PIXEL_SPACING" values are calculated from the inputs that have been made. After the image is accepted, these 
values are applied to the DICOM header of the corresponding image. The calibration function can be repeated at 
any time. 

 

Figure 50: Input of the reference measurement for the calibration 

6.7.5 Statistics 

Using these functions, selected areas in the picture can be defined in various shapes ( , , , ) , which a 
statistical evaluation should be carried out for. After selecting a statistic area based on one of the predefined shapes, 
the "Statistics" function window opens (see 6.8.1.5), if it not already in the view. Within this area, you then have the 
option to calculate the statistical characteristics of this area and to set them in relation to the complete image. 

6.7.6 Colour/Width 

The colour palette that is opened by clicking on the "Colour" button can be used to select a colour for the 
corresponding annotation, ahead of applying text, shapes and measurements. The colour can also be changed 
retrospectively. You can also define the line width for the annotation from the corresponding dropdown list. This 
line width can also be changed both before and after annotations are made. The selected colour and line width are 
used on all selected annotations and on those that are subsequently drawn. 

6.7.7 Arrangement 

This section deals with the functions from the “Arrange” section on the "Annotation / Measurement" tab. 

6.7.7.1 Select objects 

If shapes have been inserted in an image, these can be selected individually, in order to edit them further or to 
delete them. 

6.7.7.2 Foreground/Background 

If several annotations are superimposed on each other, you can use these functions to define the order in which 
they are superimposed. To do this, you first have to select the object with "Select object" and then click on 
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"Foreground" or "Background" respectively until the required position is reached in the sequence. The last annotation 
to be selected then remains selected. 

6.7.7.3 Select/deselect all 

If you click on these buttons, all the annotations in the image are selected or deselected, respectively. 

6.7.8 Delete 

This function can be used to delete selected or all annotations. 

6.7.9 History 

With this function or a procedure can be revoked or repeated. There is no limit to the number of steps that can be 
revoked or repeated. 
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6.8 View 

The functions from the "View" tab (see Figure 51) from the ribbon are described in the following section. 

 

 

Figure 51: View 

6.8.1 Show 

This section deals with the functions from the “Show” section on the "View" tab. 

It offers the option of showing/hiding the additional ("floating") function windows, Image bar, Navigator, Finding, 
Histogram, Statistics and Filmstrip in the PROPAXX viewer. 

6.8.1.1 Image bar 

When opening images, they appear first as a small preview image in the image bar. The image bar is divided into 
three sections (see Figure 52), in order to separate the different image types that can be viewed at the same time. 
The upper section contains the images from the active patient (intrasystem images). The reference images are 
opened in the central section and the external images are displayed in the lower section of the image bar. You will 
find the "Close all" button in the header of the "Reference Images" and "External Images" sections, which is used to 
close all the images in the corresponding section. When an image is closed, it is not only removed from the image 
bar but also from the lightbox, if it was being displayed there. The header of each section can be shown and hidden 
using the double-arrow icon or with a double-click, in order to be able to optimise the use of the available space. 

 

 

Figure 52: Image bar 
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Not yet accepted images, for example all external images, are marked in the image bar with the -symbol. Images, 

which are also shown in the lightbox, are labelled with the -symbol.  

6.8.1.2 Navigator 

The patient work queue that is put together by the administration can be viewed and maintained in this floating 
window. Each patient is represented in the work queue by name, date of birth and sex (see Figure 53).  

As patients' images cannot be viewed concurrently because only one patient is active at a time, the navigator offers 

the option of scrolling to the previous or next patient using the   buttons in the function bar above the work 
queue. You can also switch directly to any patient by double clicking on the corresponding entry in the work queue. 
When you change the active patient, only the corresponding opened images are removed from the image bar and 
the lightbox view. The patient record itself remains in the work queue and can be called again at any time.  

It is also possible through the function bar to accept all images from one patient and to remove individual or all 
patients from the work queue. 

 

Figure 53: Work queue in the navigator 

6.8.1.3 Finding 

The user can create, modify or view the content of a finding through the "Finding" window (see Figure 54). The 
window opens automatically as soon as a new findings file is created for the current patient. The corresponding file 
is loaded into the text area of the window. Patient data is automatically inserted into the document at defined 
positions, based on the template used for creating a finding file. The user can also insert patient data into the 
opened finding file, in the form of tags. The predefined text elements are reached through the "Insert element" 
button. If image findings are defined for images of a patient, they are reached through the “Image findings” button. 
The function bar above the text area allows a new findings file to be created and an existing findings file to be saved 
and/or deleted. You can also print the finding, export it as an RTF file or send it by e-mail. 
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Figure 54: Finding editor 

6.8.1.4 Histogram 

If an image is opened and selected in the lightbox, you can view the greyscale distribution (the histogram) in the 
corresponding image by opening this function window. As well as displaying, the histogram area (see Figure 55) 
also enables the interactive modification of the window values, the greyscale threshold values, in which the image 
should be displayed. This function corresponds to the "Windowing" function from the 6.5.1.1 section. With lower 
values, the greyscale distribution can also be shown in a logarithmic form (see "Log" checkbox Figure 55). 
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The ,  and  buttons fulfil the histogram functions "Full", "Fit" and "Reset" that were already described in 
sections 6.5.5.1, 6.5.5.2 and 6.5.5.3. 

If you hover the mouse over the greyscale distribution, you can read out the exact value ("Greyscale") and the 
number of pixels in the image ("Pixel count"), that the greyscale value under the mouse pointer have. 

You can also enter defined window values in the "Favourites" list (  button), in order to be able to use them later 

on further images (  button). Each favourite entry is shown in the list with its name, position and window width. 
When creating a new favourite window, a small dialog opens where the user can enter the name of the entry. The 
window values are read off automatically from the window currently defined in the histogram. Entries can be 

deleted again from the list with the  button. 

The favourite function is user-dependent, i.e. a favourite list is maintained for each user. 

 

Figure 55: Histogram 

6.8.1.5 Statistics 

If you have defined an area in the image through a shape from the "Statistics" group (see 6.7.5) , statistical values 
such as mean value, minimum, maximum, pixel count and signal-to-noise ratio can be evaluated for this area, by 
clicking on the "Calculate" button in this function window. In this case, a histogram is created for the defined image 
structure. Statistical values are also calculated over the complete image for comparison purposes. 

3  

Figure 56: Evaluation of a statistical surface 
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6.8.1.6 Filmstrip 

This window allows to navigate through the frames of an opened sequence. 

 

Figure 57: Filmstrip 

6.8.2 Overlays 

This section deals with the functions from the “Overlays” section on the "View" tab. 

Further view components such as Grid, Ruler, Overlays and Alignment can be activated here. There is a checkbox for 
each element, which is used to control whether the corresponding view component is visible or not. 

6.8.2.1 Text 

This function is used to show and hide the patient and image data, which is displayed for the image that is loaded 
in the lightbox. The content of the overlay can be adjusted through the configuration. 

6.8.2.2 Histogram 

Here you have the possibility to display a histogram in the image. 

6.8.2.3 Grid 

Here, you can display the grid for the lightbox. The unit, scale and colour of the grid can be set through the 
configuration. 

6.8.2.4 Ruler 

If this function is active, a ruler appears at the upper and left edge of each tile in the lightbox. The unit, scale and 
colour of the ruler can be set through the configuration. 

6.8.3 Lightbox 

This section deals with the functions from the “Lightbox” section on the "View" tab. 

6.8.3.1 Tiling 

The tiling can be changed over the 9 buttons. The following tilings are available: 1x1 tiling ( ), 2x1 tiling ( ), 3x1 

tiling ( ), 1x2 tiling ( ), 2x2 tiling ( ), 3x2 tiling ( ), 1x3 tiling ( ), 2x3 tiling ( ), 3x3 tiling ( ). 

6.8.3.2 Additional lightbox 

You can use this function if you want to display several images or if you want to work with several monitors. It makes 
a second display window available, which can also be on a second screen. A further lightbox is available in this 
display window, where the tiling can be set and images can be loaded independently of the primary lightbox. A 
maximum of 8 additional lightboxes can be used. 
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Figure 58: Additional lightbox 

6.8.3.3 Alignment 

If 1x2, 2x1 or 2x2 tiling is defined, this function allows you to align images from neighbouring tiles in the lightbox 
with each other. Figure 59 shows four images in a 2x2 tiling, before using the "Alignment" function. The result 
following use of the "Alignment" function can be seen in Figure 60. 

 

Figure 59: Images in a 2x2 tiling 

 

Figure 60: Aligned images in a 2x2 tiling 

6.8.4 Interpolation 

Here you select between two interpolation methods. 

6.8.5 Reset layout 

This function returns the layout of the program window to its initial state. Any changes made by the user, e.g. 
visibility and position of the floating function windows are overwritten of this function is used. 
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6.9 Quick access toolbar 

Each button from the ribbon and the start menu can be added or removed to the Quick Access Toolbar/QAT trough 
its context menu (see Figure 61). The button then appears additionally as a small icon in the quick access toolbar 
area (see Figure 6) and is therefore visible at all times. You have quick access to the corresponding function at all 
times through this function. 

 

Figure 61: Context menu to a function button from the ribbon 

A quick access button can be removed from the quick access toolbar using the context menu (see Figure 62). 

 

Figure 62: Context menu of a quick access button 

6.10 Status bar 

As Figure 63 shows, the status bar is divided into four sections. 

The section containing information about the active patient is in the left section of the status bar. By clicking on the 
name of the active patient you can open the overview of all his images.  

In the second section, messages retrieved from the server could be displayed. With the next icon you can get 
information about the configured storage locations. Additionally, the second section shows the greyscale at the 
position of the mouse pointer as well as the width and height of the selected image in pixels and the size of the 
active image is given in Megabyte (MB). 

The third section shows the defined tiling for the active lightbox and facilitates the definition of a new tiling, using 
the available list.  

The fourth has a slide controller for the interactive modification of the zoom factor. 

1st section 2nd section 3rd section 4th section 

   

 

 

Figure 63: Construction of the status bar 
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6.11 Shortcut 

Table 6 gives an overview of the shortcuts that are available in PROPAXX. These are split into two levels: Level 0 
without (see also Figure 64) and Level 1 with use of the "CTRL" key (see also Figure 65). The functions can only be 
called through the shortcuts if they are also defined and/or released in the corresponding licence file (Viewer type). 

Shortcut Function  Shortcut Function 

Esc Windowing  CTRL + F2 Fit to screen 

   CTRL + F3 1:1 (view) 

F1 Help  CTRL + F4 Fullscreen 

F2 Info  CTRL + F5 Full (Windowing) 

F3 Administration  CTRL + F6 Fit (Windowing) 

F4 Overview  CTRL + F7 Reset (Windowing) 

F5 Windowing  CTRL + F12 
Close all images (active patient, reference images, 
external images, documents) 

F6 Panning    

F7 Select object  CTRL + 1 1 x 1 tiling 

F8 Magnifier  CTRL + 2 1 x 2 tiling 

F9 Accept images  CTRL + 3 1 x 3 tiling 

F10 Accept image as new  CTRL + 4 2 x 1 tiling 

F11 Raw image  CTRL + 5 2 x 2 tiling 

F12 Close image  CTRL + 6 2 x 3 tiling 

   CTRL + 7 3 x 1 tiling 

Insert Add image comment  CTRL + 8 3 x 2 tiling 

Delete Remove selected annotations  CTRL + 9 3 x 3 tiling 

Page up Previous image    

Page down Next image  CTRL + A Select all objects 

   CTRL + C Copy to Clipboard 

+ (number keypad) Add keyword  CTRL + D Deselect all 

   CTRL + H Show DICOM header 

   CTRL + I Invert 

   CTRL + M Move image to another tile 

   CTRL + O Open image 

   CTRL + P Print image 

   CTRL + R Reset all changes 

   CTRL + S Save image 

   CTRL + Y Repeat (annotations/measurements) 

   CTRL + Z Undo (annotations/measurements) 

     

   CTRL + Delete Clear all annotations 

     

   
CTRL + "-" (number 
keypad) 

Zoom out 

   
CTRL + "+" (number 
keypad) 

Zoom in 

Table 6: Shortcuts in the PROPAXX viewer 
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Figure 64: Shortcuts in level 0 

 

Figure 65: Shortcuts in level 1 (in combination with the "Ctrl" key) 
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6.12 Info 

The dialog shown in Figure 66 can be called up through the  button in the right-hand area of the ribbon. General 
information such as version number, current Viewer licence and the user who is logged in for the current session is 
shown here, together with the dealer data. The licence agreement that was accepted during installation can be 
viewed again through the "View license" button. 

 

Figure 66: Info dialog 

6.13 Help 

Explanations and advice about the individual program points can be found in the Help function. 
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6.14 Storage of external images 

Images opened as external images (see 6.2.3) can be saved in the PROPAXX system using the "Accept" function. As 
PROPAXX stores all images in the DICOM format, the images that are to be imported must have a complete DICOM 
header. In the case of non-DICOM images as well as with DICOM images with incomplete header information, the 
missing data will be requested from the user through corresponding input dialogs. Non-DICOM images are stored 
in the system as so-called "OT" images. Image editing operations are not allowed on OT images. OT images are 

identified through the symbol  under the overlays in the lightbox. 

A prerequisite for the storage of external images is that the image is not yet present in the system. Image 
identification is done through the SOP instance UID in the DICOM header of each image. 

An external DICOM images must first be opened and then accepted, in order to be able to store it in the system. If 
any of the header information is missing, a corresponding dialog appears for the information type in question, 
where the missing information can be entered (see Figure 67 and Figure 68). Mandatory fields are highlighted in 
red. The image is saved once the inputs have been made and then by clicking on "OK". 

 

 

Human version  VET version 

Figure 67: Input dialogs for the patient data when storing incomplete DICOM images 

 

Figure 68: Input dialogs for the owner data when storing incomplete DICOM images (  VET version) 
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The storage of non-DICOM images is done in a similar way, with the difference that the input screen (see Figure 69 
and Figure 70) is more detailed than with the incomplete DICOM images. Mandatory fields are also highlighted 
here in red. The mandatory fields for the OT image input dialogs can be defined though the "Mandatory fields SC" 
configuration section. 

 

Figure 69: Input dialog when storing non-DICOM images (Human) 
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Figure 70: Input dialog when storing non-DICOM images (  VET version) 
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7. Configuration 

The configuration user interface in the PROPAXX Viewer is made up of several themed sections. Each configuration 
section is described individually in the following figures. Changes to the configuration are only activated after 
clicking on the "Save" button. Using the "Dump" button, you can export all the configuration settings as a text file. 

7.1 Annotations and measurements 

The appearance of annotations and measurements can be influenced through the settings in this configuration 
section (see Figure 71). 

 

Figure 71: Configuration Annotations and measurements 
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7.2 Automatic steps 

If the resetting of search criteria is not active in the administration (default setting), the results of the last search are 
always shown when opening the administration window. You can further define in this configuration section (see 
Figure 72) whether the patient administration automatically opens at every start of the Viewer. If the configuration 
item “Accept unaccepted images automatically” is enabled, the internal not accepted images will be accepted as 
soon as the images leave the lightbox. 

 

Figure 72: Configuration Automatic steps 
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7.3 Clinical finding 

In this configuration section (see Figure 73), the favorites list of the image findings can be managed. 

 

Figure 73: Configuration Clinical finding 
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7.4 Common 

In this configuration section (see Figure 74) can be defined whether the ribbon “Filter / LUT” will be displayed or 
not. 

 

Figure 74: Configuration Common 
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7.5 CONAXX 

The configuration section (see Figure 75) contains the communication data to CONAXX. 

 

Figure 75: Configuration CONAXX 
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7.6 Dealer data 

The configuration section (see Figure 76) contains the dealer contact data. 

 

Figure 76: Configuration Dealer 
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7.7 General DICOM settings 

This configuration section (see Figure 77) contains general DICOM settings. "AE title" is the name of that Viewer 
Station that is used for the DICOM services, e.g. DICOM Query. This goes together with the PC name and cannot be 
changed. 

The character set for the text coding can be modified though the "Character Set" listing. 

 

Figure 77: Configuration DICOM Common 
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7.8 DICOM Print settings 

In the subsection “DICOM Printer” you can configure the connection data to the available DICOM Printer. You define 
then in the section “Print profiles” (Figure 79) various combination of DICOM Printer, medium type and size, that 
you later use by the processing of the DICOM Print job. By clicking on the “Add” button appears the dialog from 
Figure 79 appears in which you can configure the particular settings of each print profile. 

 

Figure 78: Configuration DICOM Print 1 
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Figure 79: Defining of DICOM Print Profiles 

Separate from the print profiles you can additionally define which elements have to be visible on the hardcopy 
(Figure 80). If the check box “Activate DICOM printer status request” is active a message box with information about 
the status of the DICOM printer is shown after the print process. Note: Not all DICOM printers support this service. 

 

Figure 80: Configuration DICOM Print 2  
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7.9 DICOM Query settings 

The connections to the DICOM Servers that should be queried through the DICOM query function are defined in 
the "DICOM Query SCP" area (see Figure 81). The query result quantity can be limited through the "Max. number" 
properties for patients, examinations, series and images. The next configuration area offers the option to limit the 
modalities that are searched for. 

As the selected images from the queried PACS have to be transferred in PROPAXX and sent to the Viewer that 
originated the request with the DICOM Query communication, the connection data back to the PROPAXX Viewer 
have to be defined in the configuration property "Port”. 

 

Figure 81: Configuration DICOM Query 
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7.10 DICOM Send 

The connection data to the DICOM Servers that are used as the target when sending images using DICOM Send, 
are defined in this configuration (see Figure 82). 

 

Figure 82: Configuration DICOM Send 
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7.11 Export 

Various settings for the export functions “Send via e-mail” and “Save as” in the file formats PNG, JPG, BMP, TIFF and 
GIF can be made in this configuration section (see Figure 83). 

 

Figure 83: Configuration Export 
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7.12 Image view 

The settings in this section allow the modification of the standardly used unit and measure as well as the grid lines, 
colour of the annotations, grid and ruler. The visibility of the grid unit can also be controlled (see Figure 84). All the 
settings made in the configuration section are user-based. 

 

Figure 84: Configuration Image view 



PROPAXX 
User manual 

PROTEC® GmbH & Co. KG Page 75 of 100 

 

7.13 Institution 

The name and address of the institution/practice can be entered in the configuration section (see Figure 85). 

 

Figure 85: Configuration Institution 
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7.14 Mandatory field configuration for the storage of non-DICOM images 

The user has to supply additional information when storing non-DICOM images. In this configuration section, you 
can define which the mandatory fields are. All possible mandatory fields are listed in Figure 86. 

 

Figure 86: Configuration Mandatory fields SC 
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7.15 Overlay configuration 

In this configuration section, you have the option of defining the content and position of the texts that are shown 
in the opened image. All available information fields are listed in the central area of the user interface (see Figure 
87). They can be assigned to one of the four corners of the image. Using the overlay “DICOM Tag” you are able to 
configure any DICOM tag as an overlay. If you add the overlay “DICOM tag” a dialog will appear. Here the DICOM 
tag number can be entered. Also a description can be added optional. If you remove this kind of overlays the 
possibility exists to delete it permanently or to remove it only. If you choose the option remove, the overlay is added 
to the list in the central area and you can add this overlay to another location. 

You also have the option of resetting the arrangement of the overlay back to default values as well as defining the 
font and the colour for the text. 

 

Figure 87: Configuration Overlays 
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7.16 Print settings 

Various settings for the print function can be made in this configuration section (see Figure 88). 

 

Figure 88: Configuration Print 
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8. Server User Interface 

As with the PROPAXX Viewer, an authentication is also necessary for the PROPAXX Server application. After starting 
the PROPAXX Server the login dialog (see Figure 89) appears. The login data for the server is the same as for the 
viewer. 

 

Figure 89: PROPAXX Server login 

After a successful login, the server application main window, the so-called "Control Center", appears (see Figure 90). 
This is divided into two principal parts. All available function points are listed in the left-hand area of the "Control 
Center". Some of them may be hidden, depending on the user rights (see Table 3). A corresponding user interface 
is loaded in the right-hand area when a function is selected. 
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8.1 Status monitor 

The status monitor (see Figure 90) gives general information about the server version and the number of patients 
and images in the system. Additionally, the monitor gives information about the currently available viewer licences 
and the number of licences made available through the licence package. Next to the licence display, there is list 
with all configured storage locations, a list of the currently logged-in users, their users, the viewer types in use and 
the names of the PCs the users are logged on. This display can be refreshed from time to time with the "Refresh" 
button. 

 

Figure 90: Status monitor 
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8.2 Messaging 

With this function it is possible to send a message to all registered user (PROPAXX Viewer). This message will appear 
in all PROPAXX Viewer as an incoming message in the status bar. 

 

Figure 91: Messaging 
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8.3 Backup and recovery 

These functions allow data and image files from PROPAXX to be backed up and recovered. It is also possible to 
make a simple database backup (only the data base) with the separate program PROPAXX.Backup.Console.exe. You 
can find this program in the installation directory of the PROPAXX Server. The use of this program and the 
subsequent recovery are described in chapter 11.3.1.  

 

Figure 92: Backup and recovery 

8.3.1 Backup 

Here you have the option of starting a backup process manually (see Figure 92). This covers creating a copy of the 
currently stored images and data to a predefined storage location. The backup can be started by clicking on the 
"Start" button in the “Backup” section after selecting the folder path in the file system. As well as the actual image 
data, the database structure is also saved as part of the backup routine. They are saved as follows in the selected 
path: 

Name Description 

backup[Date and time of the backup] 
Sub-folder in the selected backup path that contains 

the data of a backup process 

1 
Sub-folder in the backup[Date and time of the backup]-

folder, which contains the image data 

backup[Date and time of the backup].pbi 
pbi file in the backup[Date and time of the backup]-

folder, contains information about the backup 
process. 

backup[Date and time of the backup].sql 
sql script in the backup[Date and time of the backup] 

folder, database backup 

Table 7: Structure in the backup path 
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There is a progress display during the backup. The process is completed with a status message. 

The additional program PROPAXX.Backup.Console.exe provides the same functionality as a console program and 
offers therefore the possibility to integrate it into automated routines of external backup tools (see 11.3.3). 

8.3.2 Recovery 

Recovery is done using the program PROPAXX.Restore.exe (see11.3.4), in order to be able to start the recovery 
process outside the PROPAXX Server as well. 

Nevertheless, there is still the option to call up this tool if required, through the "Start" button in the "Restore" section. 
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8.4 User administration 

This section (see Figure 93) in the server user interface facilitates the administration of user accounts in PROPAXX. 
The list gives an overview of the available users and their roles. Authorised users can generate new users with 
corresponding authorisations, through the "New" button. Existing user details can be modified with "Edit". There is 
a corresponding dialog for each of these functions (see Figure 94). User accounts can be deleted through the 
"Delete" button. With these actions it should be noted that you can only generate, edit or delete users whose 
authorisation levels are less than your own (see 3.1). You can however edit your own user account with the 
exception of the username. 

 

Figure 93: User management 

Generating a user account Editing a user account 

  

Figure 94: Create/edit user account 
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8.5 Storage management 

This function category allows the definition and the moving of storage locations, which contain the image store. It 
is also possible to migrate the complete data store from an external PACS into PROPAXX using DICOM Query, in 
this section. 

New storage locations can be defined ("Add" button) and storage paths that are no longer used and empty can be 
deleted from the list, in the "Manage Storage Locations" section (see Figure 95). An existing path can be changed 
using the button “Relocate path”. The list provides information about free disk space and read and write access for each 
storage location. In addition, it is possible to define single storage locations as “read-only”. This prevents the import of new 
images in read-only storage paths, but previously saved images are still accessible. 

The next section offers the option of moving the image store from the original storage location to another one. 
Only predefined storage paths are available for this purpose. 

The connection data required for reading out from an external DICOM archive are entered in the “PACS migration" 
section. "Start date" defines the age of the images that are to be migrated, based on their creation date. All images 
that meet the defined criteria are imported into PROPAXX by click on the "Start" button in the "PACS migration" 
section. The progress of the migration process can be followed in the area underneath the button bar. 

 

Figure 95: Storage management 
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8.6 Configuration 

The configuration is described in detail in section 9. 

9. Configuration Server 

The PROPAXX Viewer configuration user interface is constructed in the same way as that of the viewer. Changes to 
the configuration are only activated after clicking on the "Save" button. Using the "Dump" button, you can export all 
the configuration settings as a text file. 

9.1 Compression 

If the compression module has been included as part of the system purchase, the settings for automatic 
compression process can be made in this configuration step.  

 

Figure 96: Configuration Compression 

 

9.2 Dealer data 

See Chapter 7.6 
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9.3 DICOM Storage/Storage Commitment SCP 

This configuration step (see Figure 97) contains the connection data for the DICOM Storage/Storage Commitment 
SCP service on the PROPAXX Server. Using this connection, any DICOM-Send-Client can address DICOM images to 
the PROPAXX Server. 

 

Figure 97: Configuration DICOM Storage/Storage Commitment SCP 
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9.4 DICOM Worklist 

This configuration section contains the connection data for the DICOM worklist service of PROPAXX server. This 
service is used solely for retrieving missing patient data within the image import. 

 

Figure 98: Configuration DICOM Worklsit 

 

9.5 Institution 

See Chapter 7.13 
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9.6  Registration 

The registration of the PROPAXX software can be done in this section of the server. 

The hardware key is generated and the corresponding action is carried out using the three buttons "Copy key to 
clipboard", Save key as..." and "Send key via mail…". 

Using the "Import license package" (see Figure 99) and then selecting the licence file, this can be imported in 
PROPAXX. Changes are only activated after the PROPAXX Server has been restarted. 

Details about the currently used licence package are listed under "Current license package". 

 

  

Figure 99: Configuration Registration 
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10. Server service 

The PROPAXX Server functionality is realised by a Windows service “PROPAXX Server”. This service starts 
automatically during the Windows start process.  

 

10.1 Start the service 

To start the PROPAXX Server service open the Section “Services” from the Windows Control Panel. Select the 
service “PROPAXX Server” and use the function “Start” from the context menu. 
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10.2 Stop the service 

To stop the PROPAXX Server service open the Section “Services” from the Windows Control Panel. Select the 
service “PROPAXX Server” and use the function “Stop” from the context menu. 
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11. Additional Programs 

11.1 Viewer configurator 

A Wizard appears the first time the PROPXX Viewer is started where the connection to the PROPAXX Server has to 
be defined. The PROPAXX Viewer configurator (see Figure 100) gives you the option to change these settings 
retrospectively. Use the PROPAXX.ViewerConfigurator.exe executable file in the PROPAXX Viewer installation folder 
to start the program. Changes made through the Viewer configurator are only activated after the PROPAXX Viewer 
has been restarted. 

11.1.1 Common 

You can configure in the section “Common” after how many days the local cache should be cleaned up. 

 

Figure 100: PROPAXX Viewer Configurator - Common 
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11.1.2 PROPAXX Server 

In the section “PROPAXX Server” you can choose between a local installation and a network installation. In case of a 
local installation, it is assumed that PORPAXX Server and Viewer are on the same computer. By the network 
installation the PROPAXX Server is available for other PROPAXX Viewer stations in the network. 

 

Figure 101: PROPAXX Viewer Configurator – PROPAXX Server 

If the network installation option is selected, all connections to individual PROPAXX Servers are listed. Only one can 
be active concurrently.  

A new connection can be generated or a connection selected from the list can be edited, through the "New" and 
"Edit" buttons respectively. Both dialogs from Figure 102 are available for entering the data. A selected connection 
can also be deleted. 

  

Figure 102: Enter/modify connection data to PROPAXX Server 
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11.1.3 Burning 

The path to an external burning program can be entered in the section “Burning”.  

 

Figure 103: PROPAXX Viewer Configurator - Burining 

11.1.4 Interfaces 

The GDT/BDT/EMR interface can be activated in the section “GDT/BDT/EMR”. Also an import folder can be defined. 

The orthopaedic planning software can be activated and configured in the section “Orthopedic planning software”. 

 

Figure 104: PROPAXX Viewer Configurator - Interfaces 
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11.2 Server configurator 

The Server configurator gives you the option to set the connection settings to the database used. Use the 
PROPAXX.ServerConfigurator.exe executable file in the PROPAXX Server installation folder to start the program. 

The Server configurator user interface consists of a main window (see Figure 105), where you can choose between 
the default database created automatically during the installation of the PROPAXX Server and a custom PostgreSQL 
database. 

The connections to the existing PostgreSQL databases are listed as soon as the option “Custom database” is 
enabled. Only one can be active concurrently. 

  

Figure 105: PROPAXX Server configurator 

A new connection can be generated or a connection selected from the list can be edited, through the "New", 
“Duplicate” and "Edit" buttons respectively. Both dialogs from Figure 106 are available for entering the data. 

   

Figure 106: Enter/modify connection data to PostgreSQL database 

A selected connection can also be deleted. 

Changes made through the Server configurator are only activated after the PROPAXX Server has been restarted. 
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11.3 Tools for backup and recovery of the database 

Following additional programs for backup and recovery are available in the install directory of the PROPAXX Server. 

PROPAXX.DBBackup.Console.exe Create a backup only of the database structure. There is no image data 
included. 

PROPAXX.DBRestore.exe Restore the backup created with PROPAXX.DBBackup.Console.exe. 

PROPAXX.Backup.Console.exe Create a backup of the database and the image store. 

PROPAXX.Restore.exe Restore the backup created with PROPAXX.Backup.Console.exe or via the 
user interface of PROPAXX Server. 

 

11.3.1 Backup of the database 

You can perform a backup of the database by using the program “PROPAXX.DBBackup.Console.exe. It is a console 
program. 

To perform the backup you have to run the program as follows: 

PROPAXX.DBBackup.Console.exe [Path to the backup folder] 

Figure 107 shows the backup tool in use. 

 

Figure 107: Run the PROPAXX.DBBackup.Console.exe 

The specified backup folder must exist at backup time. The result from the backup is a SQL file created in the backup 
folder, which includes the structure and the contents of the database. The name of the backup file is automatically 
generated according to the pattern: 

backup[date and time of the backup].sql 

Before starting this program you must shut down PROPAXX (Viewer and Server). 

11.3.2 Restoring the database 

In order to restore an existing database backup you have to use the program „PROPAXX.DBRestore.exe“ (Figure 108). 
Firstly, the connection data to the database has to be entered. The appropriate text boxes are already filled with 
data from the server configuration at the start of the program (see 11.2). Select in the text field “SQL file” the 
database backup file that has to be restored. The PROPAXX Server has to be shut down before starting the recovery. 

The result is a copy in structure and content that matches the originally backuped database to the backup time. 
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Figure 108: PROPAXX.DBRestore.exe 

In order that PROPAXX can work with the restored database you have to assure, that the image files are located at 
the same path after recovery, before the backup was made. If the database connection has changed after the 
recovery, you have to adjust the local configuration of the PROPAXX Server with the help of the program 
ROPAXX.ServerConfigurator.exe (Section 11.2). 

11.3.3 Backup of the database and the image store 

The program „PROPAXX.Backup.Console.exe“ creates a backup of the database and the image store. The result of this 
backup has the same content and form as the backup you can make via the PROPAXX Server user interface. (s. 8.3.1). 

To perform the backup you have to run the program as follows: 

PROPAXX. Backup.Console.exe [Path to the backup folder] 

Figure 109 shows the backup tool in use. 

 

Figure 109: Run the PROPAXX.Backup.Console.exe 

The specified backup folder must exist at backup time. 

11.3.4 Restoring of the database and the image store 

Firstly, the connection data to the database that should be used after the recovery has to be entered through the 
recovery program user interface (see Figure 110). 

You need the pbi file created during the backup in order to carry out the recovery (see 8.3.1). This can be entered 
manually in the "Backup file" text field or selected through the "..." button. After this, the old image storage path that 
contains the backup, appears in the list underneath the text field. At the same time, there is the option to select the 
target path where this image store should be restored to. By default, it is the original storage path. 

The PROPAXX Server has to be shut down before starting the recovery process ("Start" button in external restore 
tool). 
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Figure 110: External restore tool 
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12. FAQ, Troubleshooting and Hints 

Which backup strategy is the right one? 

The following options are available: 

• Manual backup of the database and the image files 

o In PROPAXX Server (-> Backup and recovery -> Backup) you can perform a backup from the 
database structure and content as well as from the entire image pool. 

o The restore of the backup data can be performed by the Recovery-Tool integrated in PROPAXX 
or via the program PROPAXX.Restore.exe (in the install directory of PROPAXX Server). 

• Automatic backup of the database and the image files 

o The program PROPAXX.Backup.Console.exe (in the install directory of PROPAXX Server) offers as 
a console program the same functionality as the manual backup and can be used for integration 
into automated routines of external backup tools. 

o The restore of the backup data can be performed by the Recovery-Tool integrated in PROPAXX 
or via the program PROPAXX.Restore.exe (in the install directory of PROPAXX Server). 

• Backup only of the database 

o You can perform a backup only of the database by means of the program 
PROPAXX.DBBackup.Console.exe (in the install directory of PROPAXX Server). Make sure that the 
PostgreSQL service is running. PROPAXX Server and Viewer can run during the backup process. 

o The restore can be performed by means of the program PROPAXX.DBRestore.exe (in the install 
directory of PROPAXX Server). After restore of the database the image files have to be moved to 
the in the database referenced storage in order to make them accessible again. 

An image selected from the patient administration could not be opened in the lightbox. 

Possible reasons: 

• The storage folder is not accessible from the Server; Test if it’s possible to access the storage folder via the 
Windows-Explorer on the PROPAXX Server. 

• Failure by determination of the path to the image. Check if the requested path and image exists in the 
Server storage location. 

Hardware configuration 

Please note by the hardware configuration of the PROPAXX Server that the raw image of each new image have also 
to be saved in the PROPAXX system. This requires additional storage space. 

Viewer starts in offline mode 

• Is the Server running? 

• Access to the Server denied 

All in the installation/user manual mentioned ports have to be unblocked in the firewall configuration. 

Viewer starts, the user can not log in 

• Access to the Server denied 

All in the installation/user manual mentioned ports have to be unblocked in the firewall configuration. If 
necessary deactivate firewall at Viewer PC. 
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OutOfMemory error message 

• Too much or too large image files opened. Check if your hardware configuration complies with the system 
requirements for PROPAXX and upgrade it if necessary. 

• Restart PROPAXX-Viewer 

• Restart PC 

Connection problems after changing the network configuration 

• E.g. configuration of an energy save mode in a laptop can cause deactivating of the network card 

o Configure the energy save mode that way that the network card won’t be deactivated. 

• More the one network connection in Server configured 

o Change the order of the network connections so that the connection used by the PROPAXX 
Viewer stands at the first position 

Not all patients are visible in the patient administration in PROPAXX Viewer 

• By default there are only 20 patients visible when you open the administration; 

o Clicking on the “Start“ button starts the search for all patients or the patient with inserted criteria.  

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  


